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Audinate is not liable for any loss or damage that may be suffered or incurred in any way as a result of
acting on information in this document. The information is provided solely on the basis that readers will be
responsible for making their own assessment, and are advised to verify all relevant representation,
statements and information with their own professional advisers.

Software Licensing Notice
Audinate distributes products which are covered by Audinate license agreements and third-party license
agreements.

For further information and to access copies of each of these licenses, please visit our website:

www.audinate.com/software-licensing-notice

http://www.audinate.com/software-licensing-notice
http://www.audinate.com/software-licensing-notice
http://www.audinate.com/software-licensing-notice
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About Audinate
Audinate Pty Ltd is a leading developer of media networking technology whose products and solutions are
transforming the way the world interconnects multimedia systems. Audinate’s rapidly growing customer
base spans the broader international AV industry and includes many key industry brands.

Audinate’s hardware and software products and solutions are founded on patented technologies invented
by its world-class networking experts. They enablemanufacturers and AV system solution providers to
produce sophisticated, easy to use, pro-audio quality AV solutions over standard IP networks.

Audinate is based in the United States and in Sydney, Australia.

Digital Media Networking Perfected

About Dante
Audinate’s Dante technology provides high performance digital media networking that meets the quality
and performance requirements of professional live sound, AV installations and broadcast and recording
systems.

Designed to fully exploit the capabilities of today and tomorrow’s networking equipment, Dante provides
media transport mechanisms that eliminatemany traditional audio network design restrictions. Dante
makes it easy to set up robust, flexible digital audio networks with virtually unrestricted performance. A
Dante network can be designed with mixedGigabit and 100Mbps network speeds, simultaneously support
audio with different sample rates and bit depths, and even allow the design of network zones with different
latencies.

Dante is built on Internet Protocols — not just Ethernet. Because it uses standard IP over Ethernet, Dante
is capable of running on inexpensive off-the-shelf computer networking hardware, and with the use of
standard QoS can share installed networks with other data and computing traffic.

Dante provides sample-accurate synchronization and can deliver the very low latency required by
professional audio. Dante’s network-centric, audio-independent approach to synchronization allows
perfectly synchronized playout across different audio channels, devices and networks, even over multiple
switch hops.

Dantemakes networking a true plug-and-play process, allowing automatic device discovery and system
configuration. Dante-enabled devices will automatically setup their network configuration and advertise
themselves and their channels on the network, reducing complicated, error-prone set-up procedures.
Instead of “magic numbers”, networked devices and their input and output signals can be named tomake
sense to the user.

Dante is not restricted to allowing configuration and transmission of audio channels. Dante also provides
mechanisms to send or receive control andmonitoring information across the Dante IP network, including
equipment-specific messages and control specified and developed by a particular manufacturer.

With its strong foundations and links to current and evolving network standards, Dante is able to deliver a
level of future proofing otherwise unavailable in other types of digital audio transportation. Dante was
designed for Gigabit networks from its inception, and Dante as it exists today already incorporates aspects
of the emerging AVB networking standards. Continued evolution of its networking technology is an integral
part of the Dante roadmap.

Dante technology is available in ready-to-implement hardware and software products, reference designs
and development APIs.

For more information, please visit the Audinate website at www.audinate.com.

http://www.audinate.com/
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Introduction

About Dante Controller
Dante Controller is a software application provided by Audinate which allows users to configure and route
audio around Dante networks. It is available for PCs runningWindows XP andWindows 7, and Apple
Macs running OS X 10.6.8, 10.7 and 10.8.

Once you install Dante Controller on your PC orMac and connect it to a Dante network, you can use Dante
Controller to:

n View all Dante-enabled audio devices and their channels on the network

n View Dante-enabled device clock and network settings

n Route audio on these devices, and view the state of existing audio routes

n Change the labels of audio channels from numbers to names that suit you

n Customize the receive latency (latency before play out)

n Save audio routing presets

n Apply previously saved presets

n View and set per device configuration options including:

o Changing the device name

o Changing sample rate and clock settings

o Viewing detailed network information

o Access the device web page to upgrade firmware and license information (where supported)

o Identify a device for example by flashing LEDs (where supported)

What'sNew in version 3.2
v3.2.9

n For supported devices (Dante-MY16-AUD cards v3.3.9 and up), the Device View now includes an
HA Remote tab.

n Dante Controller for Mac now supports OS X 10.8.

v3.2.8
n Switch Configuration - supported devices allow specialist switching configurations

n Device View > Status tab - for supported devices, the 'Device Information' pane in the Device View
> Status tab now displays manufacturer, product type and product version information for the device.
Dante-specific information for the device (Dantemodel, Dante software and Dante firmware ver-
sions) is now displayed in the 'Dante Information' pane.

n Device Status View - the 'Type' and 'Version' columns have been renamed as 'Product Type' and
'Product Version'

n Various performance and stability enhancements
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Before You Install: Important Notes

PlatformsSupported
Dante Controller software is available forWindows XP (32 bit only), Windows 7 (32 and 64 bit), andMac
OS X 10.6.8, 10.7 and 10.8 running on Intel architecture.

l A display resolution of at least 1024 x 768 and screen size of at least 19” is recommended for Dante
Controller.

MinimumSystemRequirements
The tables below list theminimum system specifications for your computer to be able to use Dante
Controller.

Disclaimer: It is possible that your computer may meet the requirements below, but suffer from some
other individual performance limitation related to its particular hardware. Please seek the advice of your
computer support administrator.

General

Component Recommended Minimum Requirement

Processor 1GHz or better

Memory 512Mbyte of RAM

Network Standard wired Ethernet network interface (100Mbps or Gigabit). Wireless LAN (Wi-
Fi) Ethernet interfaces are not supported

Windows

Component Recommended Minimum Requirement

Operating
System

Windows XP SP3 and above (32-bit)
Windows 7 (32-bit and 64-bit)
NOTE: Both UTF-8 and Unicode are supported EXCEPT for host or device names;
the DNS standard does not support Unicode for these

Mac OSX

Component Recommended Minimum Requirement

Operating System Mac OS X 10.6.8, 10.7 and 10.8.
NOTE: Intel architecture only; PPC not supported
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Note: If you intend to also install Dante Virtual Soundcard on the samemachine as Dante Controller,
you will require amachine whichmeets theminimum system requirements for Dante Virtual
Soundcard.

Operating SystemUpdates
Ensure your PC orMac has the latest Windows or Apple updates installed.

Ensure Bonjour is installed
The Dante Virtual Sound card relies on Bonjour, Apple’s Zeroconf implementation.

Bonjour is installed by default onMac OSX, and no further action should need to be taken.

To download and install the latest version of Bonjour forWindows, visit:

n www.audinate.com/DownloadBonjour

Firewall Configuration
Firewall configuration forWindows Firewall andMac OSX built-in firewall is automatically handled during
installation.

Dante Controller communicates over UDP over the following ports:

n Dante Control andMonitoring: 8700-8704, 8800

If you are using a third-party firewall product, use the port information provided above to configure it
accordingly.

http://www.audinate.com/DownloadBonjour
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Installing Dante Controller

Pre-install Checklist
Have you:

n Read the previous section

n Checked that Bonjour is installed

n Uninstalled all previous versions of Dante Controller, if any

n Checked whether you need to configure your firewall

n Logged in using an account with Administrator privileges

n If you’re usingWindows, DON’T just Switch User – if you need to change user to become an admin-
istrator, log out and log back in as the new user.

Uninstalling PreviousVersions
Before installing the new Dante Controller, please uninstall any previous versions youmay have.

Windows

To uninstall previous versions of Dante Controller:

n Dante Controller version 2.x must be uninstalled via Program files > Audinate > Dante Controller
> Uninstall

n Dante Controller version 3.x can be uninstalled via Program files > Audinate > Dante Controller >
Uninstall, or via Start > Control Panel > Add or Remove Programs (called Programs and Fea-
tures inWindows 7)

Mac OSX

To uninstall previous versions of Dante Controller, please use the 'Uninstall' tool available in the new .dmg
file. Refer to Installing Dante Controller onMac OSX for more detail.

Downloading Dante Controller
Dante Controller is available for download from Audinate’s website.

To download a copy of Dante Controller:

1. Go to Audinate’s website: www.audinate.com

2. Navigate to Support > Software Downloads > Dante Controller

3. If not already logged in, you will be asked to log in or register before continuing

4. Once registered, download the required version of Dante Controller (Mac OSX orWindows XP/Vista)

This will download a self-installing Dante Controller file.

http://www.audinate.com/
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Installing Dante Controller onWindows
Once you have downloaded the self-installing Dante Controller file, navigate to the directory where you
have downloaded it (e.g. Desktop).

To install:

1. Double-click on the icon for the self-installing Dante Controller file.

2. A noticemay appear, titled Open File –Security Warning. This displays themessage “The Pub-
lisher could not be verified. Are you sure you want to run this software?”

3. Click Run to continue.

You should then see the Dante Controller SetupWizard dialog box.

4. Click Next to continue.

Note: If you have already installed Dante Controller, youmay be presented with a dialog box
directing you to use Add/Remove Programs to uninstall it. The Dante Controller Uninstall program
can also be used.

5. Assuming that you do not have an existing copy of Dante Controller installed, you will be presented
with the text of the Dante Controller License Agreement. Please read it carefully. You need to check
the box to accept the terms in the license agreement, and click Install.

6. If you do not accept these terms, click Disagree to terminate the installation.

Dante Controller will then be installed. When the installation has completed you will be presented
with a dialog box that allows you to select the option of starting Dante Controller immediately on
exiting theWizard.

If you have not installed Bonjour forWindows, the install will show an error message before
aborting. Please see the earlier section “Before you install: Important Notes” to locate the Bonjour
forWindows installer, and install Bonjour.

Installing Dante Controller onMacOSX

Note: Previous versions must be uninstalled prior to this installation. Please use the uninstaller
provided in the .dmg file if you have a previous version installed.

Note: TheMac OSX Dante uninstaller will uninstall Dante Virtual Soundcard as well as Dante
Controller.

To install Dante Controller onMac OSX:

1. Double-click the Dante Controller .dmg file. A drive icon will appear on your Desktop Finder window.
Double click on this to open.

2. Double click the Dante Controller .pkg. This will run the installer.

3. Read the license text, and if you accept the terms of the agreement, click Agree.

If you do not accept these terms, click Disagree to terminate the installation.
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Note: If you have previously installed Dante Controller, uninstall it using the uninstaller provided in
the .dmg file before re-installation.

Dante Controller will then be installed.



Dante Controller

Copyright © Audinate 2012 -15-

Dante Basics

Discovery and auto-configuration
When aDante-enabled device is connected to an IP/Ethernet network, it will automatically:

1. Configure its IP address

2. Advertise itself to allow automatic discovery

Within seconds of a Dante-enabled device connecting to a network, Dante Controller will automatically
discover and display the device, allowing you to configure channels and route audio.

Automatic network configuration

A Dante-enabled device connected to a network will automatically setup its own network configuration,
including its IP address.

If the network has a DHCP server, whichmay be the case for installed networks, it will receive its IP
configuration using the standard DHCP protocol.

On a network without a DHCP server, whichmay be the case for temporary or smaller networks, the
Dante-enabled device will automatically assign itself an address using link local protocols, in the same
way PCs and printers often do.

Automatic discovery

A Dante-enabled device will advertise information about itself to other Dante devices and Dante Controller,
including:

n Device name

n Audio channel labels

n Number of audio channels

n Sample rates and bit depths

This information can be seen when viewing a device on Dante Controller, and allows Dante devices to
determine compatibility with other devices, such as compatible sample rates to allow audio to be routed.

Differentiating between input and output channels
Channels are classified according to whether they put audio data onto or take audio data off the network:

n A channel that puts audio data onto the network is known as a transmitting, Tx or output channel.

n A channel that takes data off the network is known as a receiving, Rx or input channel.

Device and Channel Labeling
In Dante, devices and audio channels are identified by labels, not “magic numbers”. Labels can be
customized.
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n Dante routing is performed using the device and channel labels. A receive channel can be subscribed
to the name of a transmit channel at a device.

Example: “Analog L@my-transmitter” describes a channel named “Analog L” on a device
named “my-transmitter”. Device labels must be unique on a Dante network. Channel labels
must be unique on the device.

n If a device or channel is relabeled, Dante routing considers it to be a different device or channel. If
another, new device or channel is then given the old label, Dante routing will route from the new
device in place of the previous device.

Example: The power supply on “stage-box” fails and “stage-box” needs to be replaced. The
old “stage-box” is removed, and a new box is plugged in and labeled “stage-box”. Dante
receivers previously subscribed to the old “stage-box” will now automatically restore their
subscriptions to the new “stage-box”.

n Device labels must be unique on the network. If you attempt to rename a device using Dante Con-
troller to a name already in use on the network, Dante Controller will notify you and refuse to change
the name.

Example: There is an existing device on the network called “MY16-slot1”. If user attempts to
rename another device to “MY16-slot1” Dante Controller will notify the user that the name is
already in use. The device will not be renamed.

n If a new device is added to the network with a name that already exists, a name conflict is detected,
and one of the devices will rename itself by appending (2) to its name. This device will not be able to
transmit audio until it is renamed.

Note: A device that has been renamedwith (2) appended (e.g. “MY16-slot1(2)”) WILL NOT BE
ABLE TO TRANSMIT AUDIO until it is renamed. The device label must be changed by the user to be
a valid non-conflicting name before the device can become fully functional.

Rules for Labels
n All Dante labels are up to 30 characters in length. Label comparisons are case-insensitive; “Guitar”

and “guitar” are treated as the same label. Unicode and non-roman characters are not supported.

n Device labels should follow Domain Name System (DNS) hostname rules. Legal characters are A-Z,
a-z, 0-9, and '-' (dash or hyphen). Device labels must begin with A-Z (or a-z).

n Tx channel labels may use any character except '=' (equals), '.' (full stop or period), or '@' (at). Tx
channel labels must be unique on a device. Tx channel labels do not need to be unique on the net-
work as they are always qualified by device (channel@device).

n Rx channel labels follow the same rules as Tx channel labels.

Routing Audio

Routing Terminology
n Device: A devicemeans a Dante-enabled device, andmore specifically that component of the audio

equipment that implements the Dante interface. A Dante device typically has Tx and Rx channels
and other routing-related properties.
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n Transmit (Tx) channel: A transmit channel transmits audio from the audio hardware onto the net-
work.

n Receive (Rx) channel: A receive channel receives audio from the network and sends it to the audio
hardware.

n Flow: Dante audio routing creates flows. Each flow carries several channels of audio from a trans-
mitter to one or more receivers. Unicast routing creates flows to single receivers. Multicast routing
creates flows that can be received by multiple receivers. Multicast flows are assigned IDs enabling
them to be identified in Dante Controller.

n Unicast routing: Unicast flows are point-to-point from a single transmitter to a single receiver. Uni-
cast flows typically have room for 4 channels of audio.

n Multicast routing: Multicast flows are one-to-many from a single transmitter to any number of receiv-
ers. Use Dante Controller to choose what channels are to bemulticast. Unlike unicast routing, mul-
ticast flows consume network bandwidth even if there are no receivers, but do not require additional
bandwidth to addmore receivers.

n Subscription: A subscription configures a receive channel to receive audio from a transmit channel
on another Dante device.

n Subscription status: For a receive channel, subscription status indicates whether it is subscribed,
whether it is receiving unicast or multicast audio, whether the subscription is OK, or whether an error
has occurred.

Subscription

Dante routing is performed by associating a receiving (Rx) channel with a transmitting (Tx) channel. This is
called subscription.

Example: Route Tx channels 1 and 2 (labeled “Audio L” and “Audio R”) on the device labeled
“Source” to Rx channels 3 and 4 on the device labeled “Dest”.

Rx channels 3 and 4 on “Dest” are subscribed as follows:

n 3. Audio L@Source

n 4. Audio R@Source

Dante will perform the necessary audio routing to deliver the audio from the Tx channels to the Rx
channels.

Redundancy

Many Dante devices support redundant audio routing. These devices have two network interfaces, labeled
primary and secondary. Primary interfaces should be connected to one physical network. If redundancy is
being used, secondary interfaces should be connected to a second separate network. Secondary
interfaces cannot communicate with primary interfaces.
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If the secondary network is connected to a device that supports redundancy, it is enabled automatically.
Audio data is transmitted on both the primary and secondary networks simultaneously. In the event of a
failure on one network, audio will still continue to be received via the other network.

Note: Dante redundancy requires that both the primary and secondary interfaces on any redundant
device are connected using the same link speed. For example, if the primary interface is connected to
a 1Gbps switch port, the secondary interfacemust also be connected to a 1Gbps switch port.
Similarly, if the primary interface is connected to a 100Mbps switch port, the secondary interface
must also be connected to a 100Mbps switch port.

Note: Dante devices that do not support redundancy must be connected to the primary network only.
Dante Controller must be connected to the primary network.

Audio Formats

Different Dante devices may support different audio formats. Most Dante devices support either 48 kHz
24-bit PCM or 96 kHz 24-bit PCM. Some devices can be switched between 48 kHz and 96 kHz, but will
not support both at once.

It is only possible to set up a route between channels which have a common audio format. Channels
having incompatible formats will be shown in grey and will not be routable.

Flows

Dante audio routing creates 'flows'. Each flow carries one or more channels of audio from a transmitting
device to one or more receiving devices. There are two types of flow, unicast andmulticast.

Unicast routing creates flows to a single receiving device; a unicast flow typically assigns space for 4
channels of audio. Unicast flows are setup when a receiver subscribes to an available audio channel, and
are automatically removed when the receiver unsubscribes from all channels in that flow.

Multicast routing creates flows that can be received by multiple receivers. Multicast flows are assigned
IDs enabling them to be identified in Dante Controller and to facilitate their removal. In contrast to unicast
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flows, multicast flows must be set up on the transmitting Dante device before receivers can subscribe to
these flows.

Advanced Routing: Using Multicast

Dante routing is unicast by default. This means that a separate flow is set up between each transmitter and
receiver. If several receivers are all subscribed to the same channels of a transmitter, it may sometimes be
more efficient to usemulticast.

Multicast sends the same set of channels to multiple receivers. In practice, this usually means that the
audio flow is flooded throughout the network. If many receivers want the same channels, usingmulticast
can reduce overall network use, especially on the transmitter, because only one copy of each audio
channel needs to be sent, rather thanmany.

Dante receivers will automatically prefer multicast to unicast if it is available. This means that if a new
multicast flow is created containing the channels that a receiver is currently receiving as unicast, the
receiver will switch over to receiving audio from themulticast flow and the unicast flow will be removed.

ClockSynchronization
All Dante-enabled devices use the IEEE 1588 Precision Time Protocol (PTP) across the network to
synchronize their local clocks to amaster clock, providing sample-accurate time alignment throughout the
network.

One Dante device will be elected as the PTP Master Clock for the network; all other Dante devices act as
a PTP Slave Clocks to the electedmaster clock. Althoughmany Dante devices may be capable of
becoming PTP Master Clock, only one device will win the election. Devices with clock inputs (e.g. word
clock or AES3) will be preferred in the election process. A gigabit connected device is preferred over a
device connected via 100Mbps. A tie-breaker rule of the lowest MAC address is used if several equivalent
candidatemaster clocks are available. The election process may be overridden by manually setting “PTP
Preferred” master on a device.

Dante Clock Types

Each Dante hardware device can derive its clock from either its high-quality onboard clock circuit, or an
externally connected word clock. In the case of Dante Virtual Soundcard, the computer’s clock will be
used.

Clock Settings

Slave to External Word Clock
A Dante device with "Slave to External Word Clock" set will use the external word clock from its host
equipment to tune its onboard VCXO. A Dante device with this attribute set will become the PTP Master
Clock, unless there is another Dante device present with "PreferredMaster" set.

Preferred Master
Sometimes it may be necessary to force a particular device to provide the PTP Master Clock. A Dante
device with "PreferredMaster" set will always be chosen as the PTP Master Clock. If more than one
device has "PreferredMaster" set, the device with the lowest MAC address will be chosen.



Dante Controller

Copyright © Audinate 2012 -20-

Clocking and Synchronization in Redundant Networks

In a redundant network, the clock synchronization protocol operates over both primary and secondary
networks. Each network will have a designated PTP master clock; usually this will be the same device on
both networks. If this is not the case (e.g. if a non-redundant device is designated PreferredMaster) then
one device will bridge the clock synchronization information from the primary to the secondary network,
ensuring that all devices derive their clock from the same source. Redundant PTP Slave clocks will
synchronize their local clocks based on information from one of the networks they are connected to. In
event of a failure on one network a redundant device will continue to receive clock synchronization
information over the other network.

Latency
In Dante, variation in latency in the network is compensated for at the receiver. Each receiver has an Rx
latency setting. This setting defines the latency between the timestamps on the incoming audio samples
and when those samples are played out.

The typical default latency for a Dante device is 1msec. This is sufficient for a very large network,
consisting of a Gigabit network core (with up to 10 hops between edge switches) and 100megabit links to
Dante devices. Smaller, Gigabit-only networks can use lower values of latency (down to below 200µsec).
Recommended latency settings are displayed in Dante Controller andmay also be found in the
documentation accompanying the product.

Note: Theminimum latency available for a device connected to a 100Mbps network port is 1msec.

Latency and the Dante Virtual Soundcard

The Dante Virtual Soundcard allows a standard AppleMac orWindows PC to function as a Dante device.
Because the Dante Virtual Soundcard runs on a general purpose computer without special hardware to
support Dante timing requirements, additional latency needs to be added to connections received from a
Dante Virtual Soundcard transmitter.

The Dante Virtual Soundcard is configured with custom latency values for reliable operation. Dante
devices with Rx channels that are subscribed to Tx channels from aDante Virtual Soundcard transmitter
will automatically configure themselves to use these higher latency values for those channels only. The
latency on all other subscriptions on the receiver is unaffected.

Dante Control andMonitoring
In addition to automatic configuration and discovery, audio transport and routing, Dante-enabled devices
can also be controlled andmonitored in various ways. This includes being able to view and change specific
parameters, such as clock configuration settings. Dante devices are also capable of sending status events
that can be viewed using Dante Controller. Status events include changes in clock status, or network
interface changes.
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Starting Dante Controller

Where to find the Dante Controller application

Windows

By default Dante Controller will be installed in

C:\Program Files\Audinate\Dante Controller\

It can be started in several ways:

n Using the Start menu: Start > Programs > Audinate > Dante Controller > Dante Controller

n Run by going to Start > Run and entering
C:\Program Files\Audinate\Dante Controller\DanteController.exe
in the dialog box

n Navigate to the directory where it is installed, and double-click the Dante Controller icon:

Mac OSX

The Dante Controller application will be installed in the Applications folder.

To start:

n Navigate to Applications folder, and double-click the Dante Controller icon:

Or:

n Drag the icon to the Dock and click on it

Configuring Dante Controller

Network Interface Selection

Dante Controller communicates with other Dante devices on their primary network. Dante Controller needs
to know which of the network interfaces of the host computer is connected the primary Dante network.

The first time Dante Controller is run, the user may be presented with the Configure Dante Interfaces
dialog box providing a list of interfaces from which to select the primary Dante interface. Once an interface
has been selected it is remembered for future use and this dialog box will not be shownwhen Dante
Controller is run subsequently.
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The selected network interface can be changed via the 'interface selection' button in the Network
View toolbar of Dante Controller, which also brings up this Configure Dante Interfaces dialog box.

Note: YouMUST have a standard wired Ethernet network available and connected to use Dante
Controller. Wireless and other non standard wired Ethernet interfaces are NOT shown in this dialog
box, and cannot be selected.

Note: All Dante applications on the same PC orMac have a shared understanding of which interface
is the primary Dante interface. For example, if you have installed Dante Virtual Soundcard on the
same PC as Dante Controller and a new primary interface is selected from within Dante Virtual
Soundcard, Dante Controller will automatically switch to the newly selected interface and begin
operating on that interface.
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Using Dante Controller
Dante Controller presents the user with two types of window or view: Network View and Device View.

Important: After making changes to Dante network routing (e.g. subscriptions, device names,
channel labels etc.) please wait at least 5 seconds before disconnecting or powering down any
affected devices. This ensures that the new information has been properly saved to the devices.
Device configuration (e.g. sample rates, latency, clock settings) are saved instantly.

Note: Mac OSX users: Please note that the key combinations shown below are forWindows users.
When using Dante Controller on aMac, please use the “Command (CMD)” or “Apple” key instead of
the “Control” key when following the instructions below, and substitute standardMac key
combinations where applicable – see the Dante Controller menu for details.

NetworkView
WhenDante Controller is started it always begins by presenting the Network View:
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Network View Menu bar

Themenu bar in the Network View contains threemenus: File, Device and Help.

File
n Load Preset (Ctrl+L): loads a configuration from a file

n Save Preset (Ctrl+S): saves configuration for currently displayed devices to a file

n Exit (Alt+F4): Exits Dante Controller

The use of Presets is described in detail later in this guide.

Device
n Refresh (F5): Refreshes the displayed network / device data

n Device View (Ctrl+D): Opens a new Device View window

Help
n About: Shows Dante Controller version and current log file

n License: Displays the license text

n Contents (Shift+F1): Opens a help window and displays help contents

Network View Toolbar

Below themenu bar there is a toolbar with a series of icons:

The first three of these are shortcuts to Refresh , Load Presets and Save Presets functions. The fourth
icon provides a way of examining and changing the Dante network interface setting, and brings up the
following dialog box (see Configuring Dante Controller):

Network View Tabs

There are four sub-views within the Network View that can be selected by clicking on the tabs below the
menu bar and toolbar. These are as follows:

n Routing

n Device status
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n Clock Status

n Events

The use of each of these tabs is described in the next section.

Sub-viewswithin the NetworkView

Routing View

WhenDante Controller is started, it always displays the Routing Tab within the Network View. In this view
the network is shown in the form of a grid. Devices with Tx channels are displayed along the top row of the
grid, and those with Rx channels are displayed along the left-hand column of the grid. Initially a collapsed
view is presented; individual channels cannot be seen.

Note: If a device name is shown in red, it means Dante Controller has automatically detected an
error condition. Double-click the device name to seemore information. Refer to Automatic
Notification of Device Errors for further explanation.

Note: If a device has Tx and Rx channels, it is shown both along the top row of the grid and also
along the left-hand edge.

Expanding the Routing View
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The Rx channels associated with any device can be displayed by clicking on the [+] to the left of the
device name in the left-hand column of the grid. The Tx channels associated with any device can be
displayed by clicking on the [+] above the device name on the top row of the grid. When this action is
performed the grid view expands to show each channel of the device, and the [+] becomes a [-]. Clicking
on [-] collapses the view.

The Rx channels associated with all devices can be simultaneously expanded by clicking on the [+] of “[+]
[-] Dante Receivers” at the top of the left-hand column. Similarly, the Tx channels associated with all
devices can be simultaneously expanded by clicking on the [+] of “[+] [-] Dante Transmitters” at the left of
the top row. Clicking on [-] will collapse the view.

Customizing the Network View

The Network view can be customized using the “Filter Transmitters” and “Filter Receivers” boxes below
the Audinate logo in the top left-hand corner. Any text string typed into the box will filter out and only display
devices that contain that text string in either a device or channel name. The filtering is case-insensitive. For
example, in the Dante Controller Network view above, entering the string “dme” in either of the Filter fields
would display only theMY16-DME-Slot devices and their channels.

Device Channels
A Dante device has a number of channels associated with it. These are either transmit (Tx) or receive (Rx)
channels. Receive channels and devices are listed down the left side of the grid. Transmit channels and
devices are listed along the top of the grid.

Transmit channels are advertised on the network. A receiver uses this advertisement to establish a
subscription to the channel. A transmit channel can be sent to multiple receivers using unicast or
multicast.

Receive channels are connected to transmit channels via a subscription. Each receive channel will receive
audio over the network from at most one transmit channel.

Device Status View

The Device Status view can be displayed by clicking on the Device Status tab within the Network View
window.
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The Device Status view presents a network wide overview of device configuration and operating
information. The tabular view presents the following information, in columns from the left, as follows:

n Device Name: The label currently associated with the device

n Product Type: The product type

n Product Version: The product version

n Primary Address: The IP address assigned to the primary interface. IP addresses are currently
assigned via DHCP or automatically self-assigned. Self assigned addresses on the primary inter-
face will be in the 169.254.X.Y range.

n Primary Link Speed: The Ethernet link speed that the primary interface is currently operating over
(i.e. 1Gbps or 100Mbps).

n Secondary Address: The IP address assigned to the secondary interface. IP addresses are cur-
rently assigned via DHCP or automatically self-assigned. Self assigned addresses on the secondary
interface will be in the 172.31.X.Y range.

IP Address Assigned P address

Link Down Secondary Dante interface supported but not connected

Not supported Secondary Dante interface not supported

n Secondary Link Speed: Indicates the Ethernet link speed that the secondary interface is currently
operating over (i.e. 1Gbps or 100Mbps). Other values as described above for Secondary Address.

Note: A Dante interfacemay have a preferred link speed. Where it does and the primary and/or
secondary interface is not operating at that preferred link speed, the values in the Primary Link Speed
and/or Secondary Link Speed columns will be presented in red.
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Note: Older Dante devices may not support querying of some of this information. In this case the
relevant columnwill display “Not Supported”.

Clock Status View

The Clock Status tab within the Network View provides a network wide overview of the clocking state
within the network.

This view provides a convenient way of quickly scanning the network for clock information. The view is in
table format, with the following fields for each device, in columns from the left, as follows:

n Device Name: the label currently associated with the device.

n Primary Interface Clock Status: indicates the state of the PTP clock for the primary network inter-
face. Clock Status values and their meanings are as follows:

Master Device is the current PTP Master Clock on the primary
Dante network

Slave Device is a PTP Slave on the primary Dante network

Passive Device is not using clock synchronization information from
this interface

Link Down The interface is not connected to the network

Not
Supported

Where the device is non redundant the second interface is
Not Supported

Not
Available

The device does not support clock status reporting
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Devices that are configured with sample rate pull-up/down are shownwith the relevant pull-up/down value
against their Clock Status. For example, a device acting as master clock with +4.1667% pull-up will be
shown as Master +4.1667%. See Clock Domains for more information.

Note: Other transient clock states exist, which are not listed above.

n Secondary Interface Clock Status: indicates the state of the PTP clock for the secondary network
interface of a redundant device. The pull-up/down setting for the device is also shown.

n Clock Role: shows the capabilities of the device, and allows the user to select 'PreferredMaster'
status for a device. The possible values are:

Preferred Master
(checked or
unchecked)

Devicemay act as master clock

Slave only Device is not capable of becoming a PTP master

Not Supported Setting of clock role is not supported by this device

Not Available Clock Role information is not available for this
device

Checking 'PreferredMaster' raises the priority of the device in themaster clock election. If only one device
on a particular clock domain has this box ticked, it ensures that the selected device becomes master clock
(for the relevant clock domain). Whenmultiple devices have their PreferredMaster box ticked, themaster
will be elected from within that group. This is a convenient method of controlling the group of devices from
which themaster can be selected.

n Slave To External Word Clock: where a device can be slaved to an external Word Clock the value
'Yes' (and a check box) will appear in this column. When checked, this will force the device to derive
its local clock from the external word clock source. This will also ensure that this Dante device
becomes master clock for the relevant clock domain (unless another device has 'PreferredMaster'
selected). It is not normal practice to configuremore than one device per clock domain with an exter-
nal clock source. In this case, the user is assumed to have synchronized external word clock
sources (e.g. house clock). Where a device does not support slaving to an external Word Clock the
value in this columnwill be 'Not Supported'.

Note: Older Dante devices may not have the ability to report their clock status. In such cases,
regardless of whether they aremaster or slave or have some other status, their status will be shown
as “Not Available”.

Clock Domains
Dante Devices that are not configured with sample rate pull-up/down operate on the default clock domain,
using the default clock. Devices that are configured with sample rate pull-up/down operate on separate
'clock domains', which have their own dedicated PTP clocks, adjusted to account for the pulled up/down
sample rates.

Clock domains are not physically separated, they all exist on the network simultaneously. Devices with
pull-up/down synchronise to the appropriate clock for their pull-up/down setting, and ignore other clocks.
Those devices are shownwith the relevant pull-up/down value against their Clock Status in the Clock
Status tab.
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Dante devices can only transmit audio to, and receive audio from other devices on the same clock domain.
For example, a device with zero sample rate pull-up/down operates on the default clock domain, and
cannot transmit audio to, or receive audio from any devices on the +4.1667% clock domain, or the -1%
clock domain, etc.

Up to 5 separate clock domains can be supported at any one time. All clock domains have their own
master clock.

Master Clocks
The Dante network master clock, called the 'GrandMaster', is displayed at all times in the center of the
toolbar of the Network View. This is the device that is providing the time sync source for all devices on the
network.

If multiple clock domains are in use, the GrandMaster for each domain is shown, in a comma-separated
list.

Themaster clock is chosen automatically through an election process, though there are user configurable
parameters that allow prioritization of some devices in themaster clock election. Configuring a device to
have an external word clock source will force that device to becomemaster clock, unless another device
has 'PreferredMaster' set.

Checking the 'PreferredMaster' flag will always result in that device (or the device with the lowest MAC
address, if more than one device has been checked) becomingmaster clock for that domain.

EventsView
The Events tab within the Network View provides information on significant changes and failures in the
network.

Dante Controller continually monitors Dante devices and the network as a whole. It is able to watch for
problematic configurations, unexpected problems and communication failures between itself and Dante
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network devices. Events are displayed are stored in an event log. Each incident is given a severity grading,
as follows:

Information

Warning

Error

Events are also written to a log file. Each time the controller starts it creates a new log file with a time-
stamped filename, to avoid overwriting previous logs. The events pane provides a button enabling deletion
of log files more than seven days old.

You can find the path to these log files under Help > About.

AutomaticNotification of Device Errors
Dante Controller is able to identify several types of problems that a Dante devicemay experience. A
device that is found to have problems will have its device name displayed in red. Additional information
about the problem can be found by double-clicking on the device.

A device displayed in red will either have entered failsafe mode or have an identified issue with its IP
configuration. These states are described inmore detail below.

IP Address misconfiguration

Dante networks use IP Addressing to communicate. Incorrect address configuration canmake it hard or
impossible for a Dante device to communicate. Dante Controller attempts to identify and report several
types of address misconfiguration, including:

n Havingmultiple DHCP servers on the same network

n Incorrectly configured static IP addresses

n Connecting the secondary interface of a Dante device to the primary network

n Different interfaces on the same device using the same IP address subnet

If you need further information, please refer to the Troubleshooting section.

Failsafe mode

A device will enter failsafe mode when the firmware image stored on the board has become corrupted.
Although rare, this can occur when:

n The firmware update process is interrupted by power loss or network failure

n The firmware image itself that was used in an upgrade is corrupt

If your device enters failsafe mode, please use the Failsafe Recovery function in the Firmware Update
Manager application (if available) or contact your devicemanufacturer.

Device View
The Device View is used to view andmodify detailed information and settings for a specific device. Device
view can be activated by double-clicking on a device name in the Routing View within the Network View
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window, or by selecting Device View from the Device menu (CTRL-D or CMD-D) in the Network View
window. The Device View opens in a new window.

Note: Mac OSX users: Please note that the key combinations shown below are forWindows users.
When using Dante Controller on aMac, please use the “Command (CMD)” or “Apple” key instead of
the “Control” key when following the instructions below, and substitute standardMac key
combinations where applicable – see the Dante Controller menu for details.

The label of the device being viewed is displayed in themiddle of the toolbar. In the screenshot above
MY16-Slot2 is the device being displayed in the drop-down list box.

The device viewed can be changed by selecting another device from the drop-down list.

Multiple Device View windows may be opened from the Network View, so that several devices can be
examined simultaneously.

The Device View has up to five sub-views allowing the user to see different information relating to a
specific Dante device:

n Receive: display and configure device’s receive (Rx) channels

n Transmit: display and configure device’s transmit (Tx) channels includingmulticast

n Status: device software, clock and network status information

n Config: rename device and set other attributes as relevant to device type

n Baseboard: only available when the Dante device is mounted on a Dante PDK audio baseboard
(NOTE: the devicemust be in SPI Master mode)

Device View Menu bar

Themenu bar in the Device View contains threemenus: File, Device and Help.
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File
n Load Preset: loads a configuration from a file

n Save Preset: saves configuration for currently displayed devices to a file

n Exit: Exits Dante Controller

The use of Presets is described in detail later in this guide.

Device
n Refresh: Refreshes the displayed network / device data

n Device View: Opens a new Device View window

Help
n About: Shows Dante Controller version and current log file

n License: Displays the license text

n Contents: Opens a help window and displays help contents

Device View Toolbar

The Device View toolbar contains 4 buttons: Refresh, WebConfigure, Identify, andMulticast
Configuration. These provide the following functionality:

Refresh Re-load routing and configuration information for
the current device

Web Config SomeDante devices can be configured via a web
interface. This button opens a web browser window
which can be used to perform functions such as
firmware upgrades. This feature is not supported on
all Dante devices.

Identify Identify the current device by, for example, causing
its LEDs to flash. Note that this feature is not
supported on all Dante devices.

Multicast Configuremulticast transmit flows on the current
device.

The toolbar also provides a drop down list of all available devices on the network which allows the user to
switch to a different device.

Device View Tabs
Below the toolbar, the Device View window has five tabs: Receive, Transmit, Status, Device Config and
Network Config, which are described in detail below.

An additional tab, Baseboard, is only available when the Dante device is amodulemounted on a Dante
PDK baseboard (and is in SPI Master mode).
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Receive Tab

The Receive tab presents information about all channels being received, and able to be received by the
current device. The tab is arranged into two areas

n Receive Channels: Lists the Rx channels in the left pane of the window. It shows whether or not
they are connected and, if connected, the channel they are connected to and the status of that con-
nection.

n Available Channels: On the right pane of the window, lists the Tx channels from other devices that
are available for subscription by the current device.

The Receive Channels view on the left side of the tab contains three fields:

n Channel: An editable field that lists the receive channel labels for the current device. These can be
edited to change the current label of a receive channel.

n Connected To: Lists the Tx channel that the receive channel is currently subscribed to.

n Status: Lists the status of both primary and secondary subscriptions using the following icons:

Subscription is OK and audio should be flowing

No subscription, or a subscription error

Subscription is via unicast connection

Subscription is via multicast connection

A particular subscriptionmay have several symbols in its Status column. Common status icon
combinations and their meanings are as follows:
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A Unicast device successfully subscribed to a transmitter

Redundant device successfully subscribed on both primary and
secondary to the transmitter via unicast

Redundant device successfully subscribed on both primary and
secondary to the transmitter via multicast

Redundant device successfully subscribed on primary only to the
transmitter via unicast. This is typical when the secondary interface is
not connected

Available Channels
The Available Channels view on the right side of the tab lists the devices and advertized channels
available on the network. Devices that are grayed out indicate that this receiver cannot subscribe to those
channels or devices. This is typically because of amismatch in parameters (e.g. sample rate
incompatibility etc.), or because a device cannot route audio to itself.

Subscribing to Audio Channels in the Device View
Subscriptions are created by selecting a channel from the Available Channels list in the right-hand pane of
the Receive Tab, then dragging and dropping it onto the appropriate receive channel in the left-hand pane of
the Receive Tab.

Multiple channels can be selected and then dragged and dropped onto the Receive Channels Tab tomake
several subscriptions simultaneously.

Changing Rx channel labels in the Receive Tab
Rx channel labels can be changed by double clicking on the channel label and typing in a new value.

Transmit Tab

The Transmit tab is used to inspect andmodify the transmit configuration of a device.
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The Transmit Tab is arranged in two areas:

n Transmit Channels: The area on the left pane of the tab shows the Tx channels for the device, and
any user-defined channel label. It allows the user to create labels for transmit channels. Input to the
table is filtered to prevent illegal characters from being used in channel labels.

n Transmit Flows: The area on the right pane of the tab indicates how many unicast flows are cur-
rently in use, as well as themulticast transmit flows that have been configured on the device. Mul-
ticast flows are listed in ID order, including the channels contained within the flow.

Note: Unicast flow details are not displayed in the transmit flow window. The total number of
transmit flows currently in use is shown at the top of the pane. The total number of flows is the sum of
the unicast andmulticast flows in use. Themaximum number of flows that the device supports is
also shown (16 in the screenshot above).

Changing Tx channel labels
To change a Tx channel label double click on the label and type in a new one. Tx channel labels must be
unique on a single device.

Status Tab

The Status tab is used to obtain current information about a Dante device.
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The tab is divided into sections. The information presented on this tab can be very useful when

investigating networking or clocking issues in the system. The Refresh button can be used to update
this information if required.

Note: Not all Dante devices support the display of all of this information.

Device Information
This provides the following general information about the device:

n Manufacturer: The name of the devicemanufacturer.

n Product Type: The type of device.

n Product Version: The product version.

Dante Information
This provides Dante-specific information about the device:

n Model: The Dante device type.

n Software Version: The version of the Dante software running on the device.

n Firmware Version: The version of the Dante firmware running on the device.

Clock Synchronization
This provides the following information about device clocking:
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n Status: Locked indicates that the device is locked to the network PTP clock. Not Locked indicates
that the interface has not achieved lock with the network PTP clock.

n External Word Clock: No indicates that the device has been configured to use the internal clock
source. Yes indicates that the device has been configured to accept an external word clock source.
NOTE: If the device is configured to accept an external word clock source then it is important to
make sure that the host equipment has been set-up to provide a word clock to the Dante device.
Check your product manual for more information.

n Preferred: No indicates that the card has not been set to preferredmaster mode. Yes indicates that
the card is set to preferredmaster mode.

n Frequency Offset: Indicates the offset from the network clock master measured in parts-per-billion.

Primary Interface
Provides the following information about the primary network interface:

n IP address: The IP address currently assigned to the interface

n MAC address: TheMedia Access Control address of the interface, associated with the Ethernet
layer

n Tx Utilization: Shows the current total transmit bandwidth in use

n Errors: (on the same line as Tx utilization) shows the number of transmit Cyclic Redundancy Check
(CRC) or packet errors detected since the device was last started

n Rx Utilization: Shows the current total receive bandwidth is use

n Errors: (on the same line as Rx utilization) shows the number of receive Cyclic Redundancy Check
(CRC) or packet errors detected since the device was last started

Note: The Rx Utilization includes not only network traffic destined for the Dante device, but any
other multicast or broadcast traffic received at this network interface

Note: As a rule of thumb neither the Rx nor the Tx utilization should exceed about 85% of the link
speed in order to guarantee good clock synchronization performance (links are full duplex).

The graphic also indicates the speed and connected state of the interface as follows:

Indicates that the interface is running at 1Gbps.

Indicates that the link is operating at 100Mbps

Indicates that the link is not connected or that there is an error.
The IP address will read N/A, and Tx and Rx utilization will be 0
kbps.
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Secondary Interface
This provides the same information for the secondary interface that is provided for the primary interface, as
described above.

Note: The secondary network interface will only be displayed if the device supports redundancy.

Device Config Tab
This tab on the device view window allows the user to configure device specific parameters. The specific
options available will depend on the capabilities of the device. In the case where a device does not support
configuration via Dante Controller, the tab will be disabled.

Note: Dante Virtual Soundcard does not have a Config Tab available on Dante Controller. The Dante
Virtual Soundcard User Interface on the PC orMac must be used to configure these devices.

Configurable Parameters

Rename Device
Allows the user to enter a new Dante 'friendly name' for the device. The text field will contain the current
name. Legal characters for a Dante device name are "a-Z", "0-9" and “-“. The name cannot start with a
number and cannot include a space or any other character that is illegal within the Domain Name System
(DNS) that is used to specify web and email addresses on the Internet. Input is filtered to prevent renaming
using illegal characters. If the name entered is already in use by another device on the network, Dante
Controller will notify the user and refuse to rename the device.
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Example: there is an existing device on the network called “MY16-slot1”. If user attempts to
rename another device to “MY16-slot1” Dante Controller will notify the user that the name is
already in use. The device will not be renamed.

If a new device is added to the network with a name that already exists, a name conflict is
detected, and one of the devices will rename itself by appending (2) to its name. This device will
not be able to transmit audio until it is renamed.

Note: A device that has been renamedwith (2) appended (e.g. “MY16-slot1(2)”)WILL NOT BE ABLE
TO TRANSMIT AUDIO until it is renamed. The device label must be changed by the user to be a
valid non-conflicting name before the device can become fully functional.

Sample Rate
n Shows the current sample rate of the device, and allows the user to change the operating sample

rate of the Dante device. This may require the device to be rebooted to take effect. All sample rates
that the device supports are shown in the drop down box.

n Shows the current pull-up/down setting for the device, and allows the user to change the pull-
up/down setting. The pull-up/down setting can be used to adjust the sample rate of the device to syn-
chronise audio with video that has undergone frame rate conversion. For example, to synchronise
Dante audio with video that has been converted from 24 fps to 25 fps, set the sample rate pull-
up/down for any relevant Dante audio devices to +4.1667%.

Note: Changing the sample rate pull-up/down for a device places that device in a dedicated clock
domain. Dante devices can only transmit audio to, or receive audio from other devices on the same
clock domain. See Clock Status View for more information.

Receive Latency
Shows the current receive latency setting and allows the user to change the operating receive latency for
the selected device. Selecting one of the values and clicking OK will apply the latency to all flows that the
device is receiving. Some older Dante devices may show Current latency: dynamic, which is a legacy
mode of operation that negotiates aminimum latency based on device specific defaults. Selecting a
specific latency value (e.g. 1msec) will override the dynamic latency mode.

Note: The 0.15msec setting is unavailable for devices that include an internal switch.

Warning: changing the latency value will cause disruption in the audio while the flows are re-
established at the new latency setting.

Reset Device
Allows you to remotely reboot the Dante interface, and also to reapply factory settings. Rebooting the
Dante devicemay also require the audio equipment that contains the device to be reset.

Factory Reset wipes the following device configuration settings:

n User-defined device name

n User-defined channel labels

n Clock configuration (clock master / external clock master setting)

n Static IP addresses
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n Redundancy configuration

n Sample rate setting (including pull-up/down)

n Latency setting

n Any existing audio routes

NetworkConfig Tab
Use the Network Config Tab to toggle supported devices between Redundant and Switchedmodes, and to
specify static IP addresses for a device's Ethernet ports.

Dante Redundancy / Switch Configuration

Depending on themanufacturer's configuration of a device, it may be possible to toggle the device
between Redundant and Switchedmodes, or to select a Switch Configuration.

Redundant
When a device is set to Redundant, the device will duplicate Dante audio traffic to both Ethernet ports,
allowing the implementation of a redundant network via the secondary port. Not all devices support
redundancy.

Switched
When a device is set to Switched, the secondary Ethernet port will behave as a standard switch port,
allowing daisy-chaining through the device.
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Switch Configuration
Certain devices support specialist switching and/or redundancy configurations for the Ethernet ports. For
these devices, the top pane of the Network Config tab will be titled 'Switch Configuration'. Please refer to
themanufacturer's technical documentation for information on the supported switching configurations for
the device.

Addresses

Dante devices obtain IP addresses automatically by default, and in the vast majority of circumstances
there is no need to change the Addresses settings. However, static IP addresses can be assigned if
necessary.

To assign a static IP address:

1. Select 'manually configure an IP Address' for the appropriate Ethernet port.

2. Enter the IP Address and Netmask.

3. Click Apply.

The DNS Server andGateway settings are optional - the device will use network defaults if they are not
specified.

Click Revert to revert back to the previous settings.

Note: Assigning static IP addresses requires a device reboot.

Baseboard Tab

This tab on the device view window will almost always be visible, but grayed out. It is only available if a
Dantemodule is being used with an Audinate product development board.

Note: This section is only relevant if you are using an Audinate Dante PDK (Product Development
Kit) with an Audinate Dantemodule.

Note: Please refer to your Dante PDK documentation for information about these settings and how
to use them.
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HARemote
For supported devices (Dante-MY16-AUD cards v3.3.9 and up), the Device View also includes an
HA Remote tab. The HA Remote tab allows the selection of the HA Remote bridgingmode for the device.
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HA Remote is a proprietary serial control protocol used by Yamaha products. For more information about
HA Remote bridgingmodes, please download the latest version of the Dante-MY16-AUD user guide from
the Yamaha website.

Multicast Transmit FlowConfiguration
Clicking on theMulticast Configuration button in the Device View (regardless of which tab view is currently
displayed) will open a CreateMulticast Flow dialog box that allows the user to select individual channels to
add to a new multicast flow.

The window shows a list of the Tx channels for the device and allows the user to add them to the new
multicast flow that is being created, by checking the tick box next to each channel name. Once the user
has selected all the channels required, themulticast flow can be created by clicking on the Create button at
the bottom of the dialog box. To abandon creating a new multicast flow, click on the Cancel button.

A single multicast flow can contain up to themaximum supported channels per flow for this device. This is
displayed at the top of this window and is 8 channels for this device. If the user selects more than the
maximum allowed channels per flow, multiple flows will be created. Once a flow has been created, it will
appear in the list of flows in the transmit pane, along with the channels contained within that flow.
Channels cannot be added to or removed from existing flows. Each time the dialog is used to select
additional channels, a new multicast flow will be created.

By default, Dante devices "prefer" multicast over unicast. When a user clicks on a transmit channel to
make a subscription, the receiver will automatically connect to the channel via amulticast flow if one
exists. Likewise, when a channel that did not form part of an existingmulticast flow is added to a new
multicast flow then any existing unicast subscription to that channel will automatically switch over to use
the new multicast flow.

Care should be taken when deleting amulticast flow, as the existing subscriptions will convert back to
unicast. This has the potential to result in exceeding the link capacity or maximum number of flows at the
transmit device as multiple unicast flows will be established between the transmitter and its receivers. It
may be advisable to remove some or all of the audio routes prior to deleting themulticast flow.
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A good rule of thumb is to usemulticast when there aremore than two receivers for a specific audio
channel. You should also assume that the flow will flood throughout the entire network and therefore
consume bandwidth on all network links.

Note: Certain Ethernet switches support IGMP (Internet GroupManagement Protocol), a protocol
that provides the ability to “prune” multicast traffic so that it travels only to those end destinations that
require that traffic. If this is the case and IGMP is correctly configured on all the Ethernet switches
thenmulticast audio will not flood throughout the network but instead be sent only over the links
needs to deliver it to subscribed devices.
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Presets
Dante Controller supports loading and saving of audio routing configurations, known as Presets. A Preset
file contains subscription, labeling andmulticast flow configuration for a set of devices.

Saving Presets
To save a Preset, click the ‘Save Preset’ icon in the toolbar of the Network View.

Alternatively select File > Save Preset via the Network view menu bar.

A ‘Save a Preset File’ dialog window is opened allowing the user to select a directory and filename for the
Presets file to be created.

Routing view filteringmay be used to restrict the extent of preset file generation. A preset contains the
following information:

n Subscriptions for all receive channels that are displayed in themain routing view window

n Labels for all transmit channels that are displayed in themain Routing View window

n Multicast flow configuration for all devices that are displayed in either the transmit or receive area of
the routing view

Loading Presets

Note: When loading Presets It is important to make sure that there is no filtering applied in the
Routing View window.

Click on the ' Load Preset ' icon on the toolbar of the Network View, or select File > Load Preset via
the Network view menu bar to bring up the "Open a Preset File" dialog window.

This allows the user to navigate to the directory where previously saved Preset files are stored, and select
a Preset file to load.

Choose the preset file to load and click OK. This pops up a Preset Load window similar to that shown in the
following screenshot:
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Devices that will have their audio routing changed as a result of applying this preset are highlighted in
green. Devices that are present in the Preset but are currently not on the network are highlighted in red
italic. Devices and channels that will are not affected by this Preset are displayed in grey.

The expanded device view displays the subscription changes that would apply to this device. New
subscriptions, labels andmulticast flows are displayed in green, while existing elements that will be
deleted are displayed as struck out text. Subscriptions that will be changed show the new subscription in
green and the old subscription in struck out text.

Click the OK button to apply the preset or the Cancel button to cancel.
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Troubleshooting

Messages on Startup

Error Message Meaning & Actions

The Bonjour service is not available, please try
again in a few minutes. If this message persists,
please re-install the Bonjour software available
from: http://www.apple.com/support/downloads/
bonjourforwindows.html

Affects: Windows only.
Meaning: On some computers, system services may take a
long time to start when the computer is rebooted and youmay
be able to log in and open the Dante Controller application
before all required services are available.
Action: If you have already installed Bonjour, please wait a
few minutes to allow the services to start and try again. The
Dante Controller application should then start normally.

Dante Controller was unable to connect to the
Conmonmanager. Dante Controller cannot
function without this connection. This problem is
most likely caused by the Conmonmanager
service or daemon stopping unexpectedly. You
may need to restart your computer or reinstall
Dante Controller to repair this problem.

Affects: Windows only.
Meaning: Dante Control andMonitoring service is not
responding.
Action: Reboot your PC, or restart this service via Control
Panel > Administrative Services > Services.

ComputerConfiguration Checklist
Before installing Dante Controller, a computer needs to have:

n Bonjour installed (automatic for Macs)

n The user logged in with administrator privileges

A computer for use on the Dante network should have:

n Dante Controller installed

A correct Dante network configuration for the computer should have:

n The correct network interface selected

n The correct IP addresses used

Third-party PC or Mac firewall configuration
n StandardWindows andMac firewalls will be configured on installation.

n Third party firewalls will need to bemanually configured.

If your PC or has a third-party firewall installed, please read the Dante Controller and Dante Virtual
Soundcard User Guides for detailed information about firewall requirements and configuration.
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Troubleshooting Dante IPAddressConfiguration
All devices in a Dante network, including Dante Virtual Soundcard, must be using IP addresses from the
same network. When using Dante Virtual Soundcard or Dante Controller, your PC orMac must be
connected to the Primary Dante network, andmust have a correct IP address.

Note: NEW in 3.1.0: If a device name is shown in red, it means Dante Controller has automatically
detected an error condition. This will be either an IP address configuration issue, or the device has
entered failsafe. Double-click the red device name to seemore information.

Correct IP configuration

Dante hardware devices are set to obtain their IP address automatically from the network. They will either:

n Automatically assign themselves an address in the range 169.254.*.* (172.31.*.* for the secondary
network if present), or

n Obtain an IP address from aDHCP server if it is present on the network

Dante Virtual Soundcard uses the IP address of the PC orMac it is installed on. If the computer has more
than one wired Ethernet network interface, it will use the IP address of the selected network interface.

Your PC orMac TCP/IP network configuration set should be set to use "Obtain an IP address
automatically". This way it will automatically acquire an Link Local automatic IP address in the same
network as other Dante devices. If a DHCP server is present, the PC and Dante devices will all acquire
their IP addresses via DHCP.

Possible IP network configuration mistakes

Possible network configuration errors are listed below. Dante Controller will try to automatically detect
these. If detected the offending device will be displayed in red.

PC/Mac IP misconfigurations
n Accidentally havingmultiple network interfaces with addresses in the same subnet

General IP misconfigurations
n Accidentally havingmultiple DHCP servers on the same network

Unusual – for example someonemay have a PC connected to the network with a DHCP server
running that they’re not aware of.

n Incorrectly configured static IP addresses

You shouldn’t need to configure static IP addresses at all. If for some unusual reason you do, it
must be in the same subnet as the rest of the network.

Redundant network misconfigurations
Setting up a redundant network is described in “Redundancy”. There are a few ways of misconfiguring a
redundant network. More than one of these can be present at the same time.

n Connecting the secondary interface of a Dante device to the primary network
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Most commonly by either misunderstanding how redundancy works, and using only one switch
with all cables connected to it; or correctly using two switches or networks, but accidentally
connecting one secondary cable to a primary network switch

n Joining the primary and secondary Dante networks

By connecting primary and secondary switches, or perhaps just using one switch.

n Multiple interfaces on the same device using the same IP address subnet

Possibly by having the sameDHCP server on both primary and secondary networks, or both
DHCP servers configured to serve the same IP addresses

What are the symptoms of using the wrong network interface on my
PC or Mac?

If you havemore than one wired network interface, and Dante Controller is not using the interface the rest
of the Dante device are connected to:

n Dante Controller cannot see any Dante devices

n Dante Virtual Soundcard is not sending or receiving any audio when it is expected to

How do I check which network interface my Dante Controller/Dante
Virtual Soundcard is using?

n The selected network interface can be viewed or changed via the 'interface selection' button in
the Network View toolbar of Dante Controller.

n It can also be viewed on the Dante Virtual Soundcard Settings tab

n If the Dante network is standalone and does not have a DHCP server installed, this address should
be 169.254.*.*

n If the Dante network is using a DHCP server, the IP address should conform to the addressing
scheme it is using (as shown in the image above)

How do I check IP addresses for all devices on my network?
n Use the Dante Controller Device Status tab to view the IP addresses of all the devices on your net-

work.
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n The Primary Address of all devices should follow the same IP address scheme (e.g. 169.254.*.* or
10.12.0.*). Same for secondary addresses…

n Note that some older Dante devices or devices running older firmwaremay not show this infor-
mation.

Troubleshooting Switch Configuration and Cabling
Cables are themost vulnerable part of a network system. If you suspect cabling issues, check for:

n Faulty or manually terminated cables

n Unplugged /badly connected Ethernet cables

n Misconfigured switches

n Dante devices removed or turned off

Symptoms of switch or cabling issues
n You cannot see (some) devices in the Dante Controller network view

n Dante Controller shows orange “unsuccessful subscription” icons, which usually means a device
that was present earlier is now missing

n Faulty cables can lead to intermittent faults, whichmay be heard as dropped samples or “cracks” in
the audio

n Dante devices may appear and disappear in Dante Controller

Switch and Cabling Checklist
n Are all the connected link/status lights on the switch lit or flashing as expected?

o Is the switch powered on?

o Is the cable correctly plugged in at the switch and the PC or equipment?

n Is the switch correctly configured?

o Perhaps QoS or VLANs have been incorrectly set up

n Are you using a switch from another application with an unchecked or tested configuration?

o Consult the switchmanual and check the switch configuration
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